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＜使用手冊簡介＞ 

這本手冊將為您簡介如何使用 EndNote 來儲存參考資料和撰寫文章，讓您快速瀏覽、了解

EndNote 的重要功能與特色。 

第一單元：EndNote 簡介 

在這個單元，您將學習如何開啟 EndNote、開啟 Reference library 以及選擇、開啟、

關閉一筆 Reference。 

第二單元：更改 EndNote 的偏好設定 

在這個單元，您可以學習如何設定 Default library、修改參考文獻的型態，和改變參考

文獻在 Reference library 呈現的型態。 

第三單元：進入和管理參考文獻 

在這個單元，您可以學習進入 EndNote Reference Library 使用參考文獻，在參考文獻

中插入圖檔、搜尋參考文獻和列印參考文獻。您也可以學習如何建立和列印包含注釋的參考

書目。 

第四單元：使用 EndNote 撰寫文章 

在本單元，您將學習如何在 Microsoft Word (97、2000 或 XP) 文件中引用 EndNote 的

參考文獻，並學習如何插入引文或圖表。 
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第五單元：搜尋資料庫 

在這個單元中，您將學習到如何使用 EndNote 搜尋資料庫或線上圖書館目錄，使用

EndNote 查詢線上圖書館目錄時，您的電腦必須連線上網。 

注意： 

1. 使用前，請先確定您的電腦已經安裝 EndNote（請參考附錄一）。 

2. 手冊中所使用的 Sample 檔案，安裝在 EndNote 資料夾中的 Examples 資料夾。Examples

資料夾包含 EndNote reference library 的範本：Paleo.enl 和一些圖檔。其預設路徑為：

C:\Program Files\EndNote\Examples\Paleo.enl 
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第一單元：EndNote 簡介 

在這個單元，您將會學習如何開啟 EndNote、開啟 Reference library 和選擇、開啟、關閉

一筆 Reference。 

一、 開啟EndNote  

選擇 EndNote program 然後開啟 Sample library： 

1. 從開始 → 程式集 → EndNote → EndNote Program 

2. 選擇EndNote Program後，會跳出一個視窗，點選Open an existing EndNote library 

3. 接著開啟EndNote reference library 

♦ 在下拉選單中選擇Paleo.enl，接著點選OK 

♦ 如果Paleo.enl沒有出現在下拉選單中，點選Browse按鈕，系統會跳出一個視窗讓您

選擇，開啟Reference library 

♦ 您也可以使用檔案總管或我的電腦，點選C磁碟 → 點選Program Files資料夾 → 點

選EndNote資料夾 → 點選Examples資料夾 → 點選Paleo.enl，系統就會直接開啟

EndNote reference library目錄下的Paleo.enl範本檔案。其路徑為：C:\Program 

Files\EndNote\Examples\Paleo.enl 

♦ 另外您也可以使用EndNote reference library下的File menu來開啟檔案。 
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二、 EndNote reference library視窗 

開啟Paleo Library時，您會看到EndNote reference library視窗呈現所有的參考文獻。在

EndNote reference library的視窗中您可以看到第一作者的名字(Author)、年代(Year)、標題

(Title)。您可以利用EndNote Preferences（點選 Edit → Preferences）來修改視窗中呈現

的欄位。 

 

Reference Library視窗 

Show Preview按鈕

三、 預覽參考文獻 
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您可以透過預覽視窗(Show Preview)看到更多該筆參考文獻的資料。 

1. 點選Geophysical Research Letters這筆參考文獻 

 

預覽視窗 
Hide Preview按鈕 

2. 點選Show Preview按鈕 

3. 預覽視窗中將呈現先前所選擇呈現的書目格式 

4. 如欲選擇不同的格式，可從工具列的下拉選單中選擇欲呈現的輸出格式(如下圖)。 

 

 

 

注意： 

1. 預覽視窗中只會顯示一筆參考文獻；如果選擇多筆參考文獻，也只會呈現第一筆選取的

參考文獻。 

2. 在預覽視窗中的參考文獻可以隨時改變其呈現格式。 
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3. 點選 Show Preview 出現預覽視窗後，Show Preview 按鈕會變成Hide Preview；如

果您不要預覽視窗，可以點選Hide Preview，系統會隱藏預覽視窗。 

四、 參考文獻排序 

參考文獻可以依照作者、年代、標題進行排序。排序的步驟如下： 

1. 點一下年代(Year)的標題欄，視窗中的參考文獻將依年代遞增排列 

2. 再點一下年代的標題欄，視窗中的參考文獻則改為依年代遞減排列 

3. 如點選作者、題名，視窗中的參考文獻則會依字母依序排列。 

五、 選擇和開啟一筆參考文獻 

1. 找到作者為 Argus 的參考文獻，接著在 Argus 字母上點一下，即可選取該筆參考文

獻。您可以開啟、編輯、複製、刪除所選取的參考文獻 

2. 按鍵盤上的 enter 鍵或滑

鼠左鍵點兩下 即可開啟您

所選擇的參考 文獻 
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3. 開啟參考文獻後，會出現參考文獻的詳細資料視窗 

 

標題列 關閉按鈕

4. 在此視窗中，您可以輸入或編輯資料。視窗上方的標題列：Argus, 1993 #34 是EndNote

用於查找Library中該筆參考文獻的資訊。 

六、 關閉參考文獻 

1. 點選視窗右上角的close按鈕，即可關閉參考文獻視窗 

2. 或者從 File 中選擇 Close Reference (CTRL+W) 來關閉參考文獻視窗 

3. EndNote會自動儲存您對該筆參考文獻所做的改變。 
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第二單元：更改 EndNote 偏好設定 

這個單元將告訴您如何預設 Default library、修改參考文獻類型(加入圖片和其標題)、改變視

窗中顯示的參考文獻欄位。 

一、 開啟 Paleo Library 

如果您尚未開啟 Paleo Library (Paleo.enl)，請參考第一單元：EndNote 簡介，教您如何開

啟 Paleo Library (Paleo.enl)。 

二、 設置 Default Library 

您可以自己設置 Default Library，設定步驟如下： 

1. 從視窗最上方 Edit 中選擇 Preferences 

2. 跳出 EndNote Preferences 視窗，在視窗的左邊選項中選擇 Libraries，接者點選 Add 

Open Libraries，此時 Paleo Library (Paleo.enl)會出現在視窗上方 

 

3. 點選 Apply 儲存此一改變 
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4. 點選 OK 後，系統會自動儲存並離開 EndNote Preferences 偏好設定視窗。 

三、 修改參考型態 

1. 從視窗最上方 Edit 中選擇 Preferences 

2. 從 Preference 視窗中左邊選項選擇 Reference Types 

 

 

 

 

 

 

 

 

 

 

 

 

3. 從下拉選單中選擇欲修改的參考文獻類型，然後點選 Modify Reference Types，出現

Edit Reference Types 視窗 (如下圖) 
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4. Generic 一列會呈現所有的參考文獻類型，若將下方的捲軸往右移動，您會看到所有

EndNote 涵蓋的參考文獻類型。若將右側捲軸往下拉，您可以看到各類型參考文獻所

包含的欄位，若該欄位出現空白表示系統預設無此欄位 

6. rticle 的 Image 一列中輸入

7. 同樣在 Journal Article 一欄的 Image 下一列 Caption 中，輸入 Caption 字樣(見上圖) 

8. 點選 OK 儲存，之後您就可以在 Journal Article 類型的參考文獻中插入圖檔及其名稱。 

四、 考文獻欄位 

Reference Library

選擇 Preferences 

擇的欄位 

5. 將右側捲軸往下拉，您可以看到 Journal Article 該類型參考文獻中所有的欄位，我們將

在加入兩個欄位 

找到 Generic 一欄下方的 Image，之後在右邊 Journal A

Image 

 改變參

在 視窗中預設的欄位包括：作者、年代和標題，如果您想顯示更多的欄

位，可依照下列步驟進行： 

1. 從視窗最上方 Edit 中

2. 在 EndNote Preferences 視窗左側選擇 Display Fields。從視窗中您可以看到目前顯示

的三個欄位及兩個未被選
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在 Column 4  

在 Column 5 後的下拉選單中選擇 Caption 作為第五個呈現的欄位 

 

 

 

 

 

 

 

3. 後面的下拉選單中選取 Reference Types 作為第四個呈現的欄位

4. 

5. 點選 OK 儲存這些設定，並回到 Library 視窗 

6. 您可以在 EndNote Reference Library 視窗中，用滑鼠來移動標題欄位寬度。

 

 
拖曳此處可移動各欄位之寬度，拖曳時游標會變成左右鍵號的十字符號 
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第三單元：管理參考文獻 

在這個單元，您可以學習如何使用參考文獻、在參考文獻中插入圖片、搜尋參考文獻以及列

印參考文獻。您也將學習如何創造和列印包含注釋的參考書目。 

一、 開啟 Paleo Library 

如果您還未開啟 Paleo Library (Paleo.enl)，請參考第一單元：EndNote 簡介教您如何打開

Paleo Library (Paleo.enl)。 

二、 新增參考文獻 

利用下列方法您可以新增參考文獻： 

♦ 在Reference視窗中直接鍵入參考文獻 

♦ 利用EndNote直接查詢線上資料庫並找到所需的參考文獻 (詳見第五單元) 

♦ 從光碟資料庫中下載參考文獻並輸入至EndNote 

三、 開啟新 Reference 的步驟 

1. 選擇工具列中的 References → New Reference，這時會跳出 New Reference 視窗。

新視窗預 設為 Journal 

Article 類 型，您可以從下拉

選單中選 擇您所想要的參考

文獻類 型。 
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參考文獻類型選單



 

 

 

 

 

 

 

2. 從下拉選單中選擇 Book 

 

參考文獻類型為：Book (書籍) 

3. 輸入作者姓名 

（1） 作者姓名有兩種呈現方式 

＊ 名在前，姓在後，例如：Carol Margaret Jacobson 

＊ 姓在前名在後，例如：Jacobson, Carol Margaret 

（2） 輸入第一作者，以 Jacobson, Carol 為例 

輸入 Jacobson, Carol 時，由於 Paleo Library 中並未收錄這個作者的資料，所以
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Jacobson, Carol 會以紅色呈現。在您儲存這筆參考文獻後，EndNote 會將您所鍵入

的作者加到 Paleo Library 的作者清單(Term List)中，加入之後作者名稱會變成黑色。 

（3） 輸入第二作者，以 Roe, Jennifer 為例 

每個作者必須分別列在一列中。當您輸入 Roe, Jennifer 時，由於在 Paleo Library 中

已經收錄該作者名字，當您輸入 Roe 時，EndNote 會自動列出 Roe, Jennifer 的完整

名字。 

 

 

 

 

 

4. 輸入年代及其它資料 

（1） 用滑鼠移動到下一欄位，或使用 TAB 鍵移到 Year 年代一欄，輸入 1999 

（2） 繼續在其他欄位中輸入資料，各欄位資料如下： 

Title: Impacts of meteorites on Earth 
City: New York 
Publisher: Blackcourt Press 
Number of Pages: 100 
Abstract: The impact of a meteorite hitting earth millions of years ago may have led 

to the extinction of some marine life. 

（3） 您可以使用滑鼠移動到要編輯的欄位，用 TAB 鍵往下移或利用 Shift+TAB 鍵往前

移動。 
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關閉視窗 

由於Book這類參考文獻沒有

Series Title 和 Series Editor

兩項資料，所以這兩個欄位可

以保持空白。 

5. 當您完成所有欄位的編輯後，關閉視窗，EndNote 會自動儲存資料。您剛剛編輯的這

筆參考文獻會出現在 Paleo Library 視窗中。 

 

 

 

 

 

 

 

、 在參考文獻中加入圖片 

 
工具列，選擇 References → New Reference，出現 New 

Journal Article 

A

e feather--a suggested evolution 
leontology 

四

以下是在 Journal Article 中插入圖片的說明：
1. 在 EndNote 視窗最上方的

Reference 的視窗，預設的參考文獻類型為
2. 在作者、年代、標題等欄位中輸入下列資料： 

uthor: Tiberius Rex 
Year: 1995 
Title: The scale and th
Journal: Pa
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Volume: 23 
Issue: 9 
Pages: 23-45 

s: Feathers、Evolution、Birds 
 article discusses the evolution of bird feathers from reptilian scales. 

3 前

4. 

ferences → Insert Picture 

Note\Examples 資料夾 

r2.BMP 圖檔 

7 在 Caption

 

Keyword
Abstract: This

. 您可以使用滑鼠移動到想要編輯的欄位，利用 TAB 鍵往下移動或用 Shift+TAB 鍵往

移。如果欄位中沒有資料填入，可以跳過這些欄位不填 

利用滑鼠將捲軸往下拉，找到 Image 一欄 

5. 在 EndNote 視窗最上方的工具列，選擇 Re

6. 在出現的 Insert Picture 視窗中 

（1） 開啟 C:\Program Files\End

（2） 選擇 Feather2.BMP 並且開啟這個檔案 

（3） 在 Reference 中可以看到插入的 Feathe

 

 

 

 

 

 

 

 

. 一欄輸入 Cockatiel Crest Feathering 作為圖片說明 

8. 關閉視窗後，系統會自動儲存資料並且回到 Paleo Library 視窗。
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五、 在參考文獻中插入圖表檔案 

1. 選擇上方工具列的 References → New Reference，出現 New Reference 視窗 

Created By: Milkirk, Marie 

ft Excel 

es 

4. Object 

資料夾 

 

3） 在 Reference 這個 Excel 檔 

2. 在 Reference Type 的下拉選單中選擇 Chart 

3. 在年代、標題等欄位中輸入以下資料： 

Year: 2002 
Title: Hominid Timeline 

MicrosoImage Source Program: 
Date: May 9 

Keywords: Evolution、Hominids、Timelin

在 EndNote 視窗最上方選擇 References → Insert 

5. 此時會跳出 Insert Object 視窗 

（1） 利用 Choose File….找到 C:\Program Files\EndNote\Examples 

（2） 選擇 Hominid Evolution.xls 並開啟該檔案，之後點選 OK 插入檔案 

 

 

 

 

 

（ 中可以看到剛剛所插入的 Hominid Evolution.xls
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6. 在 Caption 的欄位中輸入 Hominid Timeline 作為此一檔案的說明。 

7. 當關閉視窗後，系統會自動幫您儲存資料並且回到 Paleo Library 的視窗。 

 

在 Caption 的標題欄中用滑鼠點一下可依 Caption 一欄進行遞增排列，再點一下會改為遞減

排列，如此您可以更快的查詢到哪些參考文獻包含圖檔(見下圖)： 

 

 

在 Caption標題
點一下即可進

行遞增排列，再

按一下 Caption
會改為遞減排

列 

 

 

 

 

 

六、 尋找已經建立的 References 

如果想要列印所有包含 extinction 而且在 1990 年以後出版的文獻，您可以利用下列步驟進

行： 
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1. 在 EndNote 視窗最上方選擇 References → Search References，跳出 Search Paleo 

Library 的視窗 

2. 在第一個檢索區中輸入 extinction 做為第一個檢索條件。您可從上方的欄位下拉選單中

選擇 Any Field，EndNote 會查找任一欄包含 extinction 的參考文獻 

3. 在第二個檢索區中輸入 1990 作為檢索條件，並且上方的欄位下拉選單中選擇 Year，在

對照選單中選擇 Is greater than or equal to 

4. 選擇布林邏輯 AND 作為兩檢索條件的連結 

 

對照選單 欄位選單 

} 
檢索項目 布林邏輯 

5. 點選 Search，EndNote 就會跳出檢索結果 

 

 

 

 

 

七、 選擇輸入格式 
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您可以從工具列右側的下拉選單中選擇您想要的輸出格式，選擇 Annotated，包含參考文

獻內容與摘要。選擇 Annotated 後即可在預覽視窗中看到 Annotated 格式的參考文獻。 

 

 

八、 列印參考文獻 

1. 在 EndNote 視窗最上方選擇 File → Print，這時會跳出列印視窗 

2. 點選列印即可進行列印 

※ 如果您想回到 Paleo Library 查看所有的參考文獻，您可以從在 EndNote 視窗最上方

選擇 References → Show All References，即可查看所有參考文獻。 
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第四單元：在 Microsoft Word 中使用 EndNote 撰寫文章 

在這個單元中，您可以學習在 Microsoft Word (97, 2000, or XP)中使用 EndNote 的參考文

獻，如何插入引文、圖表。 

一、 開啟 Paleo Library 

二、 在 Manuscript Template 中創造新文件 

1. 從工具列 Tools 中選擇 Manuscript Templates 

2. 出現 Manuscript Templates 視窗，選擇 Nature.dot，點選開啟 

 

 

 

 

 

 

 

 

3. 出現 EndNote Manuscript template wizard 視窗，點選下一步(Next) 

4. 輸入撰寫 文
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章的篇名：

Theories About Evolution，

點選下一 步(Next) 

 



 

 

 

 

 

 

 

 

5. 輸入該篇文章的作者姓名，首先選擇 Add Author，在出現的視窗中點選 New，依序輸

6. 勾選這篇文章中所要呈現的資料，如正文、摘要、參考文獻、圖表等，選擇完畢後點選

 

點選完成後，系統會開啟 Word 檔案，以及剛剛所輸入的資訊和欲呈現的資料(如下圖)，

入作者姓名及相關資料，輸入完點選確定(OK)，您所輸入的作者會建立在 Author List

中，以同樣方式可再建立其他作者資料，建立好所有作者資料後選取該文章之作者，然

後按下 OK，點選下一步(Next) 

下一步(Next)，之後點選完成(Finish) 

 

 

 

 

 

 

 

7. 
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您可開始編輯這篇文章。 

 

三、 引用 EndNote 中的參考文獻 

1. 往下移動，找到 Insert Text here 

 

2. 在 Insert Text here 中輸入您欲撰寫的文章內容，例如： 

e 220 million year-old remains 

3. 插入

→ EndNote 6 → Find Citation(s) 

The fossil in question was generally regarded to be th
of tyrannosaurus. Several years ago, however, this hypothesis was overturned by 
the discovery of yet another species. 

EndNote 中的參考文獻 

（1） 找到工具列中的 工具(Tools) 
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（2） 接著跳出 EndNote Insert Citations 視窗。在 Find 後的空格中輸入 Morehouse，點

選 Search，EndNote 會自動找出符合該條件的參考文獻。利用視窗下方可確定該

筆參考文獻是否符合您的需求，確認無誤後將該筆文獻反白，點選 Insert 可在文章

內文中插入該筆參考文獻 

 

4 在文章中加入更多參考文獻 

文，例如： 

 

 

 

 

 

 

 

 

. 

（1） 在正文中加入欲增寫的內
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It is now the undisputed progeny of the species at hand. 

（2 ation(s)，於 Find 後方空白） 找到工具列中的 工具(Tools) → EndNote 6 → Find Cit

中輸入 1987，EndNote 會自動找出符合的參考文獻 

 

（3） 從視窗上方選擇要插入的參考文獻並將該筆參考文獻反白，點選 Insert 即可插入選

除了可以插入引用的參考文獻外，也會自動將引用文獻的格式標示為符合

取的參考文獻 

（4） EndNote

Nature 的格式，如下圖： 

 

將捲軸往下移動至 References，您可以看到這篇文章的參考書目格式，如下圖： 
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（5）文章完成後，從 Word 工具列中選擇檔案 → 儲存檔案，即可儲存該篇文章。 

四、 改變參考文獻書目形態 

1. 找到工具列中的 工具(Tools) → EndNote 6 → Format Bibliography 

 

 

2. 跳出 EndNote Format Bibliography 視窗，您可以從 With output style 右邊的下拉選單中

選擇想要的輸出格式 
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3. 選擇 Author-Date 輸出格式，接著點選 OK。系統會自動幫您將數字格式的引文轉換成

Author-Date 的輸出格式 

 

 

 

五、 插入引用圖片 

1. 首先在文章中對於欲插入的圖表做一說明，例如： 

The Archaeopteryx played a pivotal role in the evolution of wings and the flight of 
birds. 

2. 從 Word 視窗上方的 Tool（工具）中找到 EndNote 6 的 Find Figure(s) 
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3. 跳出 EndNote Insert Figure 視窗，在 Find 後方空格中輸入 bird evolution，點選 Search 

 

 

 

 

 

 

 

 

4. EndNote 會自動列出符合的文獻並顯示圖片 

5. 選擇 Caption 為 Bird Evolution 的文獻，點選 Insert 

6. EndNote 會自動將該圖片插入到正在撰寫的 Word 檔案。 

六、 插入 EndNote 中的引用表格 

1. 首先在文章中對於您要插入的表格做一介紹，例如： 

While exploring the evolution of dinosaurs and birds, it becomes clear that Homo 
sapiens have occupied earth for a relatively short period of time. 

2. 從上方的 Tools（工具）中找到 EndNote 6 目錄下的 Find Figure(s) 

3. 接著會跳出一個 Insert Figure 的視窗，在 Find 後方空格中輸入 hominid，點選 Search 

 

 

4. EndNote 會自動列出符合的文獻和圖表，在此找到的是 Excel 格式的圖表 
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5. 確認要插入的參考文獻後，點選該筆參考文獻，之後點選 Insert，即可在文章中插入該圖

表(如下圖) 

 

將捲軸往下拉，可看到圖表格式 

 

※從 Figure Legends 中可以看到剛才插入的圖表與 Excel 檔。 
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第五單元：搜尋資料庫 

在這個單元，您可以學習使用EndNote搜尋線上資料庫和圖書館目錄，查詢線上圖書館目錄

時，您的電腦必須連線上網才可進行查找，以下將以查詢PubMed為例： 

一、 選擇連線資料庫 

1. 從EndNote視窗上方工具列中，選擇Tools → Connect → Connect，出現Choose A 

Connection File視窗。這個視窗會列出所有的資料庫，使用Find找到所需要的資料庫 

 
 

2. 選擇PubMed，點選Connect。接著會跳出Search “PubMed MEDLINE at PubMed 

(NLM)”視窗 
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注意： 

1. 如果您先前已經先建立了預設的檢索條件，當檢索視窗開啟時，將顯示

2. 若某一欄位標示為斜體字，那表示資料庫中無此一檢索欄位 

 

二、 查詢PubMed 

1. 從查詢視窗的欄位下拉選單中選擇Keywords (MeSH)，從對照選單中

並在下方空白欄位中輸入lasik 

 

查詢視窗  

檢索結果視

窗 

 

當您選擇連結

資料庫時，

EndNote會自

動幫您勾選

「Search 

Remote」。 
預設的檢索條件 

選擇Contains，

 
對照選單
欄位下拉選單
 

33



 

2. 點選Search，EndNote會將檢索條件傳送到PubMed，接著出現查詢結果視窗 

 

3. 如果您想進行更精確的檢索，點選Cancel關閉檢索結果視窗，回到查詢視窗 

4. 在第二個查詢欄位中輸入high diopter，並且從欄位下拉選單中選擇Any Field，從對照

下拉選單中選擇Contains，選擇布林邏輯AND連結第一個與第二個檢索條件 

 

 

選擇布林邏

輯And 

5. 點選Search，EndNote會將檢索條件傳送到PubMed資料庫，接著跳出查詢結果的視窗 
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6. 在檢索結果的視窗中點選OK，即會跳出檢索結果的參考文獻資料。 

 

三、 儲存參考文獻 

1. 選擇您欲儲存的參考文獻，從Copy Reference To選擇欲儲存的Library 

 

2. 選擇Paleo.enl，EndNote會自動把您所選擇的參考文獻加到Paleo.enl 

3. 關閉檢索參考文獻視窗時，EndNote會提醒您是否要放棄找到的參考文獻(Discard the 

xx references retrieved from “PubMed MEDLINE at PubMed (NLM)”?)，選擇確定系統
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會自動將剛才的檢索結果清除，並回到查詢畫面。 
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＜附錄一＞ 

1. 放入EndNote光碟片，選擇SETUP執行檔 

2. 出現安裝畫面，選擇Next 

 

 

 

 

 

 

 

 

 

 

 

3. 接著出現合約條款畫面，選擇Accept，可繼續安裝 

 

 

 

 

 

 

 

 

 

 

 

4. 按照系統指示點選Next逐步進行安裝 
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5. 安裝完成後選擇Finish，完成所有安裝程序 

6. 找到開始 → 程式集 → EndNote → EndNote Program，即可開啟EndNote。 
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